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Mission & Statement of Purpose

IDSVA was founded for the purpose of providing doctoral studies in philosophy and art
theory to visual artists, creative scholars, and arts professionals. With the passage of Maine
State Legislature Bill L.D. 462, signed into law by the Governor of Maine on March 1,
2007, the Institute for Doctoral Studies in the Visual Arts was granted legal authority to
confer the PhD degree. IDSVA is a Not-for-Profit 501(c)(3) institution.

MISSION

The mission of the Institute for Doctoral Studies in the Visual Arts is to operate a school of
graduate studies providing education in philosophy, aesthetics, art theory, and similar
disciplines related to the visual arts. The mission includes the provision of doctoral studies to
holders of the MFA or the master’s degree in a related field, the conferring of PhD degrees,
and otherwise providing education and training related to the arts.

STATEMENT OF PURPOSE

Traditionally the MFA has served as the terminal degree for studio artists. This degree has
trained studio artists in the skills necessary for successful art practice and has prepared artists
for teaching in college and university studio art programs. However, there is a strong sense
among today’s artists and educators that training beyond the MFA and similar degrees would
benefit many artists, architects, curators, and creative scholars, especially those who grapple
with issues surrounding contemporary media and culture. IDSVA’s pioneering curriculum---
fusing distance learning with intensive residencies---allows working art professionals to
pursue rigorous advanced scholarship without having to interrupt or abandon their teaching
careers, art practice, or other professional responsibilities.

LEARNING GOALS

Insofar as the Institute for Doctoral Studies in the Visual Arts offers to creative practitioners
a PhD in philosophy, aesthetics, and art theory, it addresses an important opportunity for
contemporary art and culture. The measure of this opportunity can be summed up in terms of
IDSVA’s primary learning goals. These include the nourishment and cultivation of:

The ability to speak and write critically and philosophically about the relationship
between the history of ideas and art in general;

The ability to teach university level courses on subjects dealing with the relation of
philosophy and art---such as courses in aesthetics, art theory, and critical theory;

The capacity to situate oneself in the history of ideas and culture in terms of one’s
creative practice and/or field of inquiry;

And lastly, IDSVA’s overarching learning goal is to nourish and cultivate an ethos of
inquiry that encourages creative thinkers to conceive new systems of knowledge.



1. Conduct of the Written and
Oral Qualifying Examinations

The Qualifying Examination incorporates two components, a Written and an Oral. The
Written Exam, and all 60 credits for the course of study, must be completed prior to sitting
for the Oral Examination.

1.1. Written Examination
Candidates successfully completing the Written Qualifying Examination shall:

a) Submit a 6,000 — 8,000 words paper for examination no later than six weeks prior
to the oral exam. This paper shall:

i) Emerge from work done in the third-year seminar;
i1) Consist primarily of an introduction to the Dissertation;
ii1) Consist of the candidate’s own writing, based on their investigations;

iv) Initiate a project that will form a distinct contribution to the knowledge
of the subject, namely:

e afford evidence of originality by the discovery of new facts and/or by the
exercise of independent critical power;

e give a critical assessment of the relevant literature, and in so doing,
demonstrate objectivity, a deep and synoptic understanding of the field of
study, the capacity to hermeneutically contextualize and interpret, and for
independent judgment in complex situations.

v) Be written in English and commensurate with the highest standards of
scholarly writing in the Humanities;

vi) Be of a standard to merit publication in whole or in part or in a revised
form (for example as an article in an academic journal);

vii) Be formatted as follows:
e Times New Roman or a similar easy-to-read serif font
e 12-point
e Double-spaced
e All margins 17
e Pages numbered in the upper right corner
e Written according to MLA style.

b) The exam shall also include:

e A final list of 12-15 titles central to the student’s research project
(a.k.a. “Student Texts”), annotated,

e A one-page, double-spaced, thesis statement;



e Outline;

e Table of Contents (simplified from the outline to reflect only chapter
headings and approximate word counts).

1.2. Oral Examination

In addition to the written exam, and the attendant documents listed in section (1.1.b) above,
each student will submit a list of the readings that comprise their particular Course of Study
at IDSVA (Course of Study Reading List). Specifically, that list will include all of the texts
read in all of the seminars, listed in the order in which they were read (NOT in alphabetic
order).

Because syllabi change from year to year, and because some students take leaves of absence
which put them “out of sync” with their original cohort, it is essential that each student
submit this list so that examiners ask questions that are appropriate to that particular student’s
program of study. To this list should be added twelve to fifteen Student Texts as chosen by
the candidate (Note: it is expected that this list will include a number of texts from the Course
of Study). As indicated above, these texts comprise the titles most central to the written exam
and projected thesis. The document as a whole is to be delivered to the Qualifying Exams
course in Canvas, along with the Written Qualifying Exam (see Appendix A, Qualifying
Exams checklist).

Candidates successfully completing the Oral Qualifying Examination shall:
a) Demonstrate a thorough familiarity with:
1) All completed seminars and directed readings;
i1) All Student Texts as chosen by the candidate.

b) Demonstrate a sophisticated understanding of the candidate’s Dissertation
topic and the key texts related to the topic;

c) Demonstrate an integrated comprehension of the key theoretical positions
relative to the candidate’s Dissertation topic and explain the position to be
represented by the Dissertation.

1.1.1. Examiners will be appointed for each candidate in accordance with IDSVA’s policy
for the appointment of examiners for the degree of PhD. At least one examiner for
each candidate must have experience as an examiner for a research degree awarded
by a U.S. higher education institution. At least one examiner will be a member of
the IDSVA faculty.

1.1.2.  All matters relating to the Oral Qualifying Examination must be treated as
confidential. Examiners are not permitted to divulge the content of the
examination to anyone other than the candidate or faculty and administrators of
IDSVA.

1.1.3.  After the Oral Qualifying Examination, a joint final report shall be prepared by the
examiners for submission to IDSVA. The joint final report will be released to
candidates for their personal information.



1.1.4. Each joint final report of the examiners shall indicate whether the candidate has
successfully met the requirements for completion of the Oral Qualifying
Examination and shall include a statement of the examiners’ judgment of the
candidate’s performance.

1.1.5. All examinations will be conducted by videoconference, on selected dates during
the month of July. In exceptional circumstances, Qualifying Examinations may
be held at other times.

1.3. Qualifying Examinations QOutcomes

Examiners have four options in determining the result of the Written Qualifying Examination,
and an additional four options in determining the result of the Oral Qualifying Examination, as
follows:

1.3.1. The Written Qualifying Examination:

a) If the Written Qualifying Examination fulfills the criteria (set out in Points
1.1 above), and the examiners are fully satisfied with the quality of the
written work, the examiners may pass the Written Qualifying Examination
without amendment.

b) If the Written Preliminary Examination otherwise fulfills the criteria but the
Examination requires minor amendments, the examiners may require the
candidate to make amendments within 2 months. The amended examination
shall be submitted to the Chair of the committee (who will consult the
committee members) for confirmation that the amendments are satisfactory.

c) If the Written Preliminary Examination, though inadequate, shall seem of
sufficient merit to justify such action, the examiners may determine that the
candidate be permitted to re-present the Written Preliminary Examination in a
revised form within 6 months. Examiners shall not, however, make such a
decision without submitting the candidate to an Oral Preliminary Examination.
The examiners may at their discretion exempt the candidate from a further oral
examination, on re-presentation of the Preliminary Written Examination. The
amended examination shall be submitted to the Chair of the committee (who
will consult the committee members) for confirmation that the amendments are
satisfactory.

d) If the examiners determine that a candidate has not reached the standard
required for the re-submission of the Written Qualifying Examination in a
revised form, the examiners may determine that the candidate has not
passed the Written Qualifying Examination.

Note: If a student is required to revise the Written Qualifying Exam, they may
elect to work with an IDSV A Post-Doc for one or two semesters for a fee of
$1000 per semester. If the resubmitted Written Qualifying Examination still
fails to satisfy the examiners, the student will be given a one-year leave during
which they can prepare to resubmit the Written Exam. During this additional
year, the student will not receive any formal supervision from IDSVA faculty.



The student must re-submit the examination within a year. If, on the third try,
the student still fails to satisfy the committee, they will be asked to withdraw
from the program and will be granted the MPhil. Additionally, if a student is
unable to satisfactorily complete a revision of the Written Examination within
two years of initial exam, their participation in the program will be terminated,
and they will be granted the MPhil.

If a student needs an additional extension on the due date for the rewrite of the
written exam, they will have to request it to the Director of the School prior to the
due date, for a period not exceeding three additional months.

Once the revision is approved, the student will be given permission to proceed
to the dissertation in the next available semester (either fall or spring).

1.3.2. The Oral Qualifying Examination:

1.3.3.

1.3.4.

a) If the Oral Qualifying Examination fulfills the criteria (set out in 1.2 above), and
the examiners are fully satisfied with the student’s performance in the
Examination, the examiners may determine that the candidate has fully passed the
Oral Qualifying Examination.

b) If the Oral Qualifying Examination otherwise fulfills the criteria but the
candidate’s performance is deemed less than fully satisfactory, the examiners may
require the candidate to re-sit the Oral Qualifying Examination within six months.

c) If the Oral Qualifying Examination, though inadequate, shall seem of sufficient
merit to justify such action, the examiners may determine that the candidate be
permitted to re-sit the Oral Qualifying Examination within 12 months. Examiners
shall not, however, make such a decision without submitting the candidate to a
Written Qualifying Examination. The examiners may at their discretion exempt
the candidate from making amendments to the Written Qualifying Examination.

d) If the examiners determine that a candidate has not reached the standard required
for re-sitting the Oral Qualifying Examination, the examiners may determine that
the candidate has not passed the Oral Qualifying Examination.

Note: If a student is asked to re-sit an Oral Qualifying Examination, but still fails
to satisfy the examiners, the student will be given a one-year leave during which
they can prepare to re-sit the Oral Exam. During this year, the student will not
receive supervision from IDSVA faculty. Additionally, if a student is unable to
satisfactorily pass the Oral Examination within two years of initial exam, their
participation in the program will be terminated, and they will be granted the MPhil.

Examiners have the right to make comments in confidence to IDSVA in a separate
report. Such comments should not normally be concerned with the performance of the
candidate but may cover, for example, matters to which they wish to draw the attention
of IDSVA.

The examiners may, at their discretion, consult the Director of the School before
completing their report, particularly if they have doubts relating to the appropriate
decision to be made.



2. Oral Examinations Study Tips

2.1.  Review the Course of Study that your cohort followed (i.e. all of the seminars). Read
all of the course descriptions that introduce the course reading lists, so as to re-
familiarize yourself with the larger philosophical/theoretical context within which the
reading list was introduced to you.

2.2. Compile and review the Course of Study Reading List. This you can do by cutting
and pasting the reading list from each of the syllabi in the order in which you took
the courses. Be sure that you review the syllabi for the courses that you actually
took. This document comprises the course headings plus the reading list and will
allow you to quickly ascertain the Course of Study's historical trajectory.

2.3.  Now review your archived seminars (Past Enrollments) in Canvas. Review in order all
of the material from your Cohort’s Discussions. Along with the Course of Study and
the Course of Study Reading List, the Discussions will begin to bring into focus the
narrative implicit to the curriculum.

2.4. Re-read all of the exam papers you wrote for the seminars. The exam questions
and your essay responses link the texts together in terms of the inter-textual
narrative referred to above.

2.5. Repeat steps 1-4. Begin noting where links in your particular narrative chain are
missing. Go back and review the texts you need to review.

2.6.  Once you have put together your own list of 15 texts, you should add it on to the list
you’ve created based on the seminar readings. Think about how your particular list
“slants the story” in a direction that is unique to your critical standpoint.

2.7. And be sure that you are not working in isolation. Create a study group with others who
are taking the exam at the same time. Those who work in groups to prepare for the orals
tend to excel, while those who try to go it alone tend to struggle or fail.

3. Dissertation for the PhD degree

The scope of the Dissertation shall be what might reasonably be expected after the completion
of the coursework curriculum and two, or at most three, years of full-time study following the
completion of coursework.

After satisfying the requirements of the Qualifying Exams, the candidate will be given
permission to proceed to the dissertation (see Appendix B), and will be assigned to a
Dissertation Director, in the next available semester. The Dissertation Director’s role is to
supervise the student’s Dissertation research, to read drafts, and to offer feedback and advice.
The candidate and director should schedule telephone/video chat meetings at least once a
month. In addition, the Dissertation Director becomes the student’s Advisor for the remainder
of their time at IDSVA. In that capacity, the Dissertation Director is expected to be able to
provide letters of recommendation for the student for professional positions and opportunities,



and to guide the student through the job application process. The Chair of Dissertation
Directors will speak with both the candidate and director at least twice per semester.

In addition to the supervising and advising role, the Dissertation Director is also responsible to
chair the Dissertation Defense, and to supervise and approve revisions in case these are asked
by the Dissertation Committee following the Dissertation defense.

Dissertation Preparation is offered during the regular Fall and Spring semesters (September to
December, and January to April, respectively, for a total of 15 weeks per semester. Students will
receive 1 dissertation credit for each semester of dissertation preparation. Candidates are
expected to enroll in dissertation preparation until the dissertation is completed and approved by
their Dissertation Director. Dissertation Directors are not expected to meet their students or read
their work during the Summer semester. However, in some cases and especially during the final
stages of writing (if the Director agrees), there might be an option for enrolling for the Summer
semester.

Candidates are considered to be enrolled half-time while enrolled in Dissertation Preparation.
Candidates receiving federal financial aid are not eligible to receive federal loans for more
than 6 semesters of dissertation preparation.

At the beginning of the semester, the candidate and director agree on a work plan for the
semester, covering both reading and writing goals. A syllabus is provided at the start of each
semester with guidelines and meeting protocols. The course is graded on a
Satisfactory/Unsatisfactory basis in light of the semester’s work plan.

Grading Scale for Dissertation Preparation

S Satisfactory
U Unsatisfactory
\\ Withdrawn

Dissertation Preparation grades will be given by the Dissertation Director. In cases where
the student has a problem with the grade received, they should bring their concern to the
Director of the School. In cases where the Director of the School is also the Dissertation
Direction, the student should bring their concern to the President.

If a student receives a grade of "U" (Unsatisfactory) for any dissertation preparation credits,
they will be placed on probation for the following term. A conference will be held between
the Director of the School and the student. Conditions of probation will be detailed in a
letter from the Director of the School. The probation letter will also explain what the
student must do to return to satisfactory academic progress. Failure to redress cause of
probation will constitute condition for dismissal.

A student on probation for one semester will continue to be eligible for federal student loans.
A student on probation for more than one semester will be denied future federal student
loans. For more detailed information, see the current IDSV A Financial Aid Handbook >
Satisfactory Academic Progress (available for download on the IDSVA website Policies and
Procedures page).

If a candidate’s dissertation director withdraws due to a loss of interest in or confidence in
the project, the candidate will be assigned to another director, but that will be the final
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chance to work with a director.

The candidate cannot ask to be assigned to another director, with the exception of extreme
circumstances: lack of time/engagement in the project, methodological incompatibility,
etc. As the first step, the candidate shall discuss the matter with the Chair of Dissertation
Committees in these cases (in case the Chair of Dissertation is the Dissertation Director,
this shall be reported to the Director of the School). If no solution can be found, the
candidate will be assigned to another director, but that will be the final chance to work
with a director.

3.1 Dissertation Guidelines

The Dissertation shall be original (adding a perspective or knowledge to the subject);
hermeneutical (listening, questioning and interpreting different approaches); critical
(building on this one main question, thesis and argument); systematic (clear structure,
justified and consistent use of methodology); be driven by a clear question, thesis and
argument, intertwining arts and philosophy. Specifically, it shall:

a) Consist of the candidate’s own account of their investigations, and must
indicate how they appear to advance the study of the subject;

b) Form a distinct contribution to the knowledge of the subject and afford
evidence of originality by the discovery of new facts and/or by the exercise of
independent critical power, give a critical assessment of the relevant literature,
and in so doing, demonstrate a deep and synoptic understanding of the field of
study, objectivity, and the capacity for independent judgment in complex
situations and autonomous work in that field;

¢) Be an integrated whole and present a coherent argument; [A series of papers,
whether published or otherwise, is not acceptable for submission as a
Dissertation. Students may publish papers that contain parts of the dissertation
prior to the completion of the dissertation itself, however papers written and
published prior to enrolling in the program, either by the candidate alone or
jointly with others, may not be included as part of the Dissertation.]

d) Be written in English and the literary presentation shall be
commensurate with the highest standards of scholarly writing in the
Humanities;

) Be of a standard to merit publication in whole or in part or in a revised
form (for example as a monograph or as a number of articles in academic
journals);

f) Include a full bibliography and references;

g) Comprise a word count of 80,000 - 100,000 words:
Include in the wordcount: Endnotes
Exclude from the wordcount: Title Pages, Bibliography, and Appendices

Appendices should only include material that examiners are not required to
read in order to examine the Dissertation, but to which they may refer if they



wish.

In the Word document, carefully select the text of the dissertation proper.
Open the Word Count dialogue box and check the option to include endnotes.

[Note: Any dissertation that does not fall within this word count needs the
approval of the Director of the School. Exceptions are considered on a case-by-
case basis, but under no circumstances shall any dissertation be accepted that is
less than 70K words.]

h) Be presented in MLA style. See the Appendix D Style Guide for additional
guidance.

3.2. Resources for the use of images in dissertations

The IDSVA Library lists a few guidelines for the use of images under copyright law. See
links below: https://idsva.libguides.com/c.php?g=780964&p=5598492)

https://www.arl.org/wp-content/uploads/2014/01/code-of-best-practices-fair-use.pdf

This guide, also linked on our library site, gives more attention to dissertations, see pages
11-13 in particular:

http://vraweb.org/wp-content/uploads/2016/09/VRA_FairUse Statement Pages Links.pdf

3.3. Key Points of Dissertation Writing

3.3.1. Make the argument the major organizer of the text. Writing an argument involves
taking a position on a particular issue, event, or question, and justifying that position.
An argument attempts to persuade the reader to a particular point of view and to the
veracity and worth of that point of view. In its simplest form an argument consists of:

e A statement of position (a thesis),

e A series of points arranged in logical order, supported by evidence and
examples, linked together by connections that emphasize their cumulative
nature, and

e A summary in which the thesis is reaffirmed and restated. There may also be
recommendations or counter points of view (to strengthen the case being made)
at this stage.

There are generally sub-arguments contained within the larger overarching case being
made (use them to organize your chapters).

Two reasons to make the argument the organizing principle of your dissertation:

a) You should be concerned with a problem, justify the importance of attending to
that problem, and persuade a reader that the evidence you have accumulated on
the topic sheds new light on the issue. The essence of doctoral dissertation is not
recount or summary. It is very extended argument — that’s why it is called a
‘thesis’. A dissertation that contains little argument will struggle to achieve the
stated goal of making a scholarly contribution.

10
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3.3.2.

3.3.3.

3.3.4.

3.3.5.

b) Scholarly work at the doctoral level is also meant to be about the unique
contribution to knowledge production made by the student/researcher. Even if the
topic has been subject to countless other studies, doctoral researches must place
their particular stamp on their work. While critical summary may rely on framing
and locating the works of others, factual recounts do little more than say what
happened, not why, nor why this is important. It is argument that provides the
opportunity for you to make your mark, to state your case, to stake a claim.

Identify the CONTEXT?*: the discourse communities, field of knowledges you are
entering into. Reflect on the process of entering into them. Understand writing as a
social practice (not as a set of skills). Understand the importance of critical evaluation
of the ‘literatures’ — the scholarship in the field of knowledge production you are
entering into, and the importance of taking a stance, evaluating other scholars and
philosopher’s works/positions:

a. Sketch out the nature of the field or fields relevant to the inquiry, possibly
indicating something of their historical development and

b. Identify major debates and define contentious terms, in order to

c. Establish which studies, ideas and /or methods are most pertinent to the study and
d. Locate gaps in the field, in order to

e. Create the warrant for the study in question, and

f. Identify the contribution the study will make.

*CONTEXT/FIELD OF KNOWLEDGE PRODUCTION

FIELD: Body of scholarship with natural boundaries and affinities (but these
boundaries can be blurred or in process; new fields can be created by bringing
together disparate fields).

KNOWLEDGE PRODUCTION: emphasizes the constructive capacity of this
intellectual work.

Note: What is in the field is more than just articles, papers, books: it also includes
other forms of knowledge production, such as artworks, industries, policies, in
sum, a range of sources that are not exclusively academic. The ‘gaps’ that your
research aims to fill may come from an intersection of various fields and modes of
production that reveal what is missing from the discussion.

Negotiate text work and identity work simultaneously (process of building the
scholar; becoming critical).

Use the metaphor of the dinner table for imagining a conversation with your key
thinkers and secondary scholars where you drive the conversation (situate your voice
in there).

Mapping the field: “Mapping ideas is about setting out, on paper, the geography of
research and thinking that has been done on a topic. At one level, it is about identifying
what has been done, when it was done, what methods were used and who did what. At
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another level, it is about identifying links between what has been done, to show the
thinking that has influenced what has been produced.” (Hart, 1998: 144)

4. Requirements applicable to Dissertations
submitted for the degree of PhD

4.1.

4.2.

4.3.

4.4

The work submitted in a Dissertation must have been done after the initial
registration for a degree.

A candidate will not be permitted to submit as their Dissertation one which
has been submitted for a degree or comparable award of this or any other
University or institution.

A candidate must have the complete Dissertation (including title) approved by the
candidate’s Dissertation Director before submitting it to the Chair of Dissertation
Committees (Dr Elina Staikou [estaikou(at)idsva.edu]). The candidate must be
enrolled in a Dissertation Prep semester at the time of submitting the final version to
the Dissertation Director for approval.

The Dissertation Director must be confident in the viability of the dissertation for the
dissertation defense before allowing the dissertation to be submitted to the Chair of
Dissertation Committees (i.e. the Dissertation Director will verify that the dissertation
fulfills all the points listed in 3.1 before signing off for approval).

5. Entry to examination and submission of Dissertation

5.1.

5.2.

5.3.

5.4.

IDSVA shall require the submission of a completed dissertation registration form for
each of its candidates. (See Appendix C. This form is available for download from the
Canvas home page.)

The dissertation registration form must be submitted to the Chair of Dissertation
Committees (Dr. Elina Staikou [estaikou(at)idsva.edu]) at least one month before
submitting the dissertation. A candidate is required to submit with the entry form an
abstract (approximately 300 words) of the content of the Dissertation to assist in the
appointment of suitable examiners. While the choice of examiners is made in
consultation with the candidate and the director, the final appointment of the Defense
Committee is made by the Chair of Dissertation Committees in consultation with the
Director of the School. Potential examiners should not be directly approached as to
their willingness or invited by students or directors to act as members of the Defense
Committee at any point.

Once the dissertation has been approved by the Dissertation Director, the candidate
does not need to enroll in the subsequent Dissertation Preparation semester which
includes the defense date.

Defenses are usually scheduled either in the fall semester (early September — mid-
December) or in the spring semester (late January—early April).

12



5.5.

5.6.

5.7.

5.8.

5.9.

5.10.

At least eight weeks prior to the requested defense date, a copy of the Dissertation must
be submitted to the Chair of Dissertation Committees as a Word document, who will
confirm that the dissertation conforms to the word count and the mechanical
requirements for the document (carefully follow Appendix D — Style Guide and
Appendix E — Title Pages). For Spring 2026 defenses, dissertations should be submitted
by January 26, 2026. For Fall defenses, dissertations should be submitted by September
8, 2026.

The Chair of Dissertation Committees will review the document and may request
formatting edits. After being approved by the Chair of Dissertation Committees, the
student should convert the Word doc into a PDF, no larger than 25MB. Printing is not
required unless requested by a committee member. Candidates will bear printing and
shipping costs as requested.

The dissertation director will serve as the chair of the dissertation defense committee.
In consultation with the Director of the School and the dissertation director, the Chair
of Dissertation Committees will choose two additional committee members and will
inform the student once those appointments have been made. The student should email
the PDF copy to each committee member, at least six weeks prior to the defense date.
The Chair of Dissertation Committees will inform the committee members that if they
would like to have a printed copy of the dissertation, they should request it directly
from the student. If a printed copy is requested, it should be printed in black & white,
single-sided, and simply bound (a coil binding is good). If the manuscript is too large
for one volume, it may be split into two volumes.

Every candidate is required to present a short abstract of the Dissertation of not more
than 300 words with each copy of the Dissertation submitted to IDSVA, included in the
Title Pages. Keywords for web searches should be listed at the end of the abstract.

If the candidate has not submitted their Dissertation for examination within 18 months
from the submission of the form of entry for the examination, the entry will be cancelled
unless for special reasons the candidate’s supervisor requests otherwise.

The candidate may make travel plans for the Commencement before the defense is
conducted, if desired. If the dissertation requires minor revisions (i.e. option ‘b’ in the
possible outcomes, p. 14) which are not submitted and approved before the
Commencement ceremony, the candidate may still participate in the ceremony and
receive a blank diploma. The diploma will be mailed once the revisions are accepted.

6. Conduct of the Dissertation Defense

6.1.

6.2.
6.3.

a)

The examiners, after reading the Dissertation, shall examine the candidate orally on the
subject of the Dissertation and, if they see fit, on subjects relevant thereto.

The standard format for Dissertation Defenses will be via videoconference.

There are five options open to examiners in determining the result of the examination,
as follows:

If the Dissertation fulfills the criteria (set out in 3.1 above) and the candidate satisfies the
examiners in all other parts of the examination, the examiners will report that the candidate
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b)

d)

6.4.

6.5.

has satisfied them in the examination for the PhD degree.

If the Dissertation otherwise fulfills the criteria but requires minor amendments and if the
candidate satisfies the examiners in all other parts of the examination, the examiners may
require the candidate to make amendments specified by them, doing so within three (3)
months. The amended Dissertation shall be submitted to the examiners or one of their
number nominated by them for confirmation that the amendments are satisfactory.

If the Dissertation otherwise fulfills the criteria but requires substantive amendments and
if the candidate satisfies the examiners in all other parts of the examination, the
examiners may require the candidate to make amendments specified by them, doing so
within nine (9) months. The amended Dissertation shall be submitted to the examiners or
one of their number nominated by them for confirmation that the amendments are
satisfactory.

If the Dissertation, though inadequate, shall seem of sufficient merit to justify such
action, the examiners may determine that the candidate be permitted to re-present the
Dissertation in a revised form within eighteen (18) months. Examiners shall not,
however, make such a decision without submitting the candidate to a Dissertation
Defense. The examiners may at their discretion exempt from a further oral examination,
on representation of the Dissertation, a candidate who under this regulation has been
permitted to re-present in revised form.

If, after completion of the examination including the Dissertation Defense for the PhD
degree, the examiners determine that a candidate has not reached the standard required
for the award of the degree nor for the re-presentation of the Dissertation in a revised
form for that degree, the examiners may determine that the candidate has not satisfied
them in the examination.

If the examiners are unable to reach agreement, their reports shall be referred to the
IDSV A Director, who shall determine the action to be taken.

A candidate who fails to satisfy the examiners (point 7.3.e) may apply to register de
novo (starting over) for a further period of study leading to a substantially new
dissertation, which will have to be approved in accordance with paragraphs 4.3 and
4.4, above. In this case, the candidate may be assigned a new Dissertation Director, at
the discretion of the Director of the School. If the candidate does not register de novo,
he or she will be automatically granted the MPhil.

7. Notification of results of the Dissertation Defense

7.1.

7.2.

7.3.

After the examiners have reached a decision, the candidate shall be notified by the
IDSVA Director of the result of the Dissertation Defense.

After any requested revisions have been approved by the committee, the candidates
should submit their final dissertations to the Chair of Dissertation Committees,
Elina Staikou.

A diploma under the seal of IDSVA shall be subsequently delivered to each
candidate who has been awarded a degree.
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7.4.  The diploma for the degree will bear the name which appears on the title
page of the submitted dissertation.

7.5.  Candidates who elect to participate in a graduation ceremony will receive their
diplomas at that ceremony; otherwise, they will be mailed.

8. Availability of Dissertations

8.1.  Dissertation abstracts are published on the IDSV A website
(http://www.idsva.edu/abstracts/). The full dissertation is published as a pdf on the
Maine State Library website.

8.2.  In addition, IDSVA has the authority to supply a copy of the abstract of each student
dissertation for inclusion in any appropriate published list of dissertations offered for
higher degrees in United States universities or in any supplement thereto, or for
consultation in any central file of abstracts of such dissertations.

8.3.  In the spirit of the dissemination of new knowledge that is a hallmark of higher
education, and in line with standard procedures in other PhD programs, dissertations
will be subject to web searches and unrestricted downloads unless the student
requests to opt out that system and have their dissertation unavailable for download
outside of the IDSVA community. A request to restrict download access to a
dissertation has an initial two-year window from the time the degree is conferred.
Guidelines associated with restricted dissertation access are:

a) The full text version of the dissertation will be available for download only to
members of the IDSVA community.

b) Web searches including the citation and abstract of restricted dissertations will
continue to be available to the general public.

c) After two years the restriction will elapse.

d) Restrictions on full text download may be renewed for another two-year period
following the date of filing after which time it will be released to the IDSVA
Library and the Maine State Library catalog and made available to the public
electronically. Note: Requests for additional restrictions should be made in
writing to the Director of the School, and the dissertation chair’s signature is
required for embargos longer than the initial two years.

e) The Dissertation Restriction Form is available from the Director of the School
upon request.

9. MPhil Degree

9.1. IDSVA grants the Master of Philosophy (MPhil) to students who complete a
minimum of 40 credits and do not go on to receive the PhD. This degree will be
made available to students who enrolled in the PhD program, and who successfully

15


http://www.idsva.edu/abstracts/)
http://www.idsva.edu/abstracts/)

9.2.

completed the first two years of coursework (40 credits) with an average of B or
better.

The MPhil is typically awarded to those who fail to pass the Qualifying Exams and to
those who either do not complete the dissertation, or who do not pass the dissertation
defense. Other circumstances, such as health and life changes, may necessitate the
granting of the MPhil. The Director of the School, in consultation with academic
advisors and core faculty members, will determine which students should be advised
to consider the MPhil instead of proceeding to the PhD.

10. Graduation

10.1.

10.2.

10.3.

10.4.
10.5.

11.

11.1.

11.2.

Graduation requires both academic and financial clearance. The Director of the
School and the Registrar will certify that all academic degree requirements have been
fulfilled. The Bursar will audit financial accounts. If academic and/or financial
clearance is not granted, a hold will be placed on the graduation process until the
academic deficiency and/or the financial obligation is cleared.

The degree is granted from the moment the candidate passes the defense, and any
revisions to the dissertation that may be required have been completed and approved.

The Commencement ceremony usually takes place in New York City in late April.
Attending the Commencement Ceremony is not mandatory to receive the PhD
degree. Candidates may choose to postpone attending the ceremony for a year if
they so wish.

Recipients of the MPhil degree are encouraged to participate in the Commencement.

There is no additional fee for graduation. IDSV A provides a hotel room for the
graduate and a guest at the commencement location for the two nights surrounding
the ceremony. The graduate must provide their own transportation to the location.
Academic regalia is optional and may be either rented or purchased by the
candidate. Please refer to the document “Academic Regalia” on the Canvas home

page.

General Remarks

The work in the Dissertation submitted by the candidate must be their own
and submission of a Dissertation for examination for the PhD degree will be
regarded as a declaration of this fact.

All work submitted as part of the requirements for any examination of IDSVA must
be expressed in the candidate’s own words and incorporate their own ideas and
judgments. Plagiarism is the presentation of another person’s thoughts or words as
though they were the candidate’s own and is an examination offense. Direct
quotations from the published or unpublished work of another must always be clearly
identified as such by being placed inside quotation marks, and a full reference to
their source must be provided in the proper form. A series of short quotations from
several different sources, if not clearly identified as such, constitutes plagiarism as
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11.3.

11.4.

much as does a single unacknowledged long quotation from a single source. Equally,
if another person’s ideas or judgments are summarized, the candidate must refer to
that person in their text and include the work to which reference is made in the
bibliography.

Allegations of plagiarism will be reviewed according to the Academic
Dishonesty Procedure as detailed in the Student Handbook, as will any other
allegations of examination misconduct, including, but not limited to:

a) deliberate attempts to represent falsely or unfairly the ideas or
work of others;

b) the invention or fabrication of data;
c) the submission of work commissioned from another person.

A dissertation director may recommend that a candidate work with an outside editor.

Additionally, candidates may on their own initiative, avail themselves of the services of

a copy editor for the final edit of the Dissertation. In either case, the candidate must
seek prior approval from the Director of the School.
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APPENDIX A. Qualifying Exams Checklist

Your Canvas submission shall include:

0 Your Written Qualifying exam, including endnotes and Works Cited

[0 A final list of 12-15 titles central to the student’s research project (referred
also as “Student Texts”), a.k.a. the “Annotated Bibliography”

[0 A one-page, double-spaced, Abstract (including thesis statement)
O Detailed Outline

[0 Table of Contents (simplified from the outline to reflect only chapter headings
and approximate word counts)

[0 Your Course of Study Reading List. This you can do by cutting and pasting
the reading list from each of the syllabi in the order in which you took the
courses (i.e., not in alphabetic order)*. The reading list will allow you to
quickly ascertain the Course of Study's historical trajectory (note: individual
texts from Art in Theory should be included as well)

*Word doc. or docx. only please. No scanning of syllabi.
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APPENDIX B.

Permission to Proceed to the Dissertation

This memo serves as official confirmation that

has successfully completed both the Oral and Written Qualifying Exams as of

and is permitted to begin the dissertation phase of doctoral

studies at IDSVA.

will be working with

as her/his Dissertation Director.
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Appendix C. Dissertation Registration Form

A copy of this form as a pdf with form fields is available on the IDSVA Canvas
Homepage.

The dissertation registration form must be submitted to the chair of dissertations (Elina
Staikou [estaikou(at)idsva.edu]) at least one month before submitting the dissertation,
and at least three months prior to the requested date of defense. A candidate is required
to submit with the entry form an abstract (approximately 300 words) of the content of
the Dissertation to assist in the appointment of suitable examiners.

Date:

Candidate’s Name:

Director of Dissertation:

Title of Dissertation:

Expected Date of Dissertation Submission (at least one month from the current date):

Requested Date (or range of dates) of Defense (at least three months from the current
date):


https://idsva.instructure.com/login/canvas

Appendix D: IDSVA Dissertation Style Guide

IDSVA dissertations must follow MLA writing and formatting guidelines. Certain points of
MLA style, the ones that tend to be common stumbling blocks for dissertation writers, are
referenced in this guide. However, there are many more MLA guidelines that do apply and are
not mentioned in this guide. All dissertation writers should refer to the most recent edition of the
MLA Handbook. There are also many helpful online resources about MLA style published by
university writing centers.

The registrar will review the formatting of the submitted dissertation to confirm that it follows
MLA guidelines. The registrar may request formatting edits to the dissertation before it is
accepted for distribution to the committee members.

1. Basic formatting:

a. Times New Roman font

b. 12-point

c. Double-spaced

d. Standard US 8.5 x 11-inch paper

e. All margins 17
f. Headers may be centered, but all other text should be left flush
g

Indent the first line of each paragraph one half-inch from the left margin. Do
not enter additional line space between paragraphs

h. Pages numbered in the upper right corner

2. Citations
a. Use in-text parenthetical citations to refer readers to entries in the bibliography.

b. Parenthetical citations for short quotes are placed before the final punctuation
mark.

c. Quotations longer than four lines should be set off as a block quote. The block
quote should be double spaced and indented half an inch from the left margin. Do
not indent the first line an extra amount or add quotation marks not present in the
source.

d. Parenthetical citations for block quotes are placed after the final punctuation of
the quote, and no punctuation follows the citation.

3. Endnotes
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The notes should be in endnote form, notated by Arabic numerals.

b. The notes should be placed at the end of the dissertation proper, not at the end of
each chapter.

c. Start the endnotes on a separate page with the title ‘Notes’ or Endnotes’ centered
at the top of the page.

d. The notes themselves should be double-spaced, with no additional line space
between entries.

4. Bibliography (referred to as ‘Works Cited” in the MLA Handbook)

a. The bibliography is placed after the endnotes. It should start on a separate page
with the title ‘Bibliography’ or ‘Works Cited’ centered at the top of the page.

b. The entries should be aligned left flush and formatted in a hanging indent style
(i.e., indent the second and subsequent lines of each citation by half an inch)

c. Double space all citations, but do not enter additional line space between
paragraphs.

5. llustrations

a. Illustrations or tables should be interpolated into the text proper unless compelling
reasons not to exist. The images should be placed between paragraphs; the text should
not wrap around the images.

b. Every illustration should have a caption below.

c. The caption may include numbering (Fig.--), and you may provide a List of
[llustrations.

d. Hlustrations should be sized appropriately for adequate reproduction quality (~150
dpi).

6. File Size

a.

The dissertation will be initially submitted to the registrar as a Word doc. If the
document is larger than the 25MB, it should be sent by Google Drive. The page
numbering and other formatting may be disrupted when viewed in Google Drive.
This is okay. The registrar will download the file for viewing, and the original
formatting is preserved in the downloaded document.

Once approved by the registrar, you should save the complete dissertation document
as a pdf file for electronic distribution. The size of the final pdf file should be 25 MB
or less.
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File Format: PDF &l

© Best for electronic distribution and accessibility
(uses Microsoft online service)

Best for printing

7. Title Pages

a. A. The title pages should match the format that appears in Appendix E. It can be
helpful to print out both your title pages and Appendix E and compare them side by
side. Appendix E is available for download as a Word doc from the Canvas home
page.

b. Pay attention to the variations in single or double spacing, and variations in left flush,
centered, or right flush elements.

c. The page numbers for the Title Pages should be in lower case Roman, while the page
numbers for the dissertation proper should be in Arabic numerals. To maintain the
two different numbering formats in your Word doc, create a new section (Insert >
Break > Section Break).

d. The very first page of the Title Pages (the Cover Page) has no page number on it.
Uncheck the box for ‘show number on first page’ in Format > Page Numbers. The
next page will be numbered ‘ii’.
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APPENDIX E.Title page and other front materials formats

A copy of this form is available as a Word Document in the IDSVA Canvas Homepage.

Erase all text with the blue highlight, and replace all text with the yellow highlight.

TITLE IN ALL CAPITAL LETTERS: CENTERED, DOUBLE-SPACED AND ALMOST

CERTAINLY TAKING TWO LINES

Your Name as you would like it to appear on the diploma

Submitted to the faculty of
The Institute for Doctoral Studies in the Visual Arts
in partial fulfillment of the requirements
for the degree
Doctor of Philosophy

Month, Year


https://idsva.instructure.com/login/canvas

Accepted by the faculty of the Institute for Doctoral Studies in the Visual Arts in partial
fulfillment of the degree of Doctor of Philosophy.

COMMITTEE MEMBERS

Committee Chair: Name, Degree
Committee chair title (faculty rank) of Area (if applicable) or Department
Committee chair institution

Committee Member: Name, Degree
Committee member title (faculty rank) of Area (if applicable) or Department
Committee member institution

Committee Member: Name, Degree
Committee member title (faculty rank) of Area (if applicable) or Department

Committee member institution

(For the initial submission for defense, enter your dissertation director as the Committee chair
and leave the other two committee member names blank. For the final submission for archiving,
fill out the committee member names.)



(optional, but strongly recommended)

© year

Your Legal Name

ALL RIGHTS RESERVED



(optional)

a quote (or two) that serve as an epigraph for the whole

(single-spaced and centered)

dedication

(single-spaced and right justified)



ACKNOWLEDGEMENTS

Acknowledgements should be single-spaced, left flush, with no indent on the first line. You can,
of course, thank anyone whom you’d like to thank. At minimum, thank your director and
committee members and the folks who have been supportive of your time at IDSVA (e.g.
partner, children, dear friends). Even if the paragraph(s) take only a few lines, the
acknowledgements get a page of their own. For multiple paragraphs, put a one line space
between each paragraph and do not indent the first line.



Vi

ABSTRACT

Your full name

TITLE IN ALL CAPITAL LETTERS: CENTERED, DOUBLE-SPACED AND ALMOST

CERTAINLY TAKING TWO LINES.

What follows on this page, and perhaps spills over onto the next, is the ABSTRACT. It
should be double-spaced, and should be NO MORE THAN 300 words. It should situate the
project by indicating what the problem/question was that you set out to investigate, what your
thesis is, and why that thesis seemed important as a contribution to scholarly inquiry. It should
not include any material that needs to be footnoted or otherwise cited, as it should be able to
stand alone as a coherent, albeit short, description of the long project. Note that it should be left-

justified.

Keywords: At the end of the abstract, add five keywords here to be used in a Web search
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This formatting for the Table of Contents and Chapter Headings does not need to be strictly
followed, and can be adapted to best suit the organization of your own dissertation.

All of the pages so far (except for the cover page), should be numbered in lower case Roman
numerals. Uncheck the box for ‘show number on first page’ in Format > Page Numbers. The
next page, which is the first of the Introduction to the dissertation proper, should be 1 (an Arabic
numeral). To maintain the two different numbering formats in your Word doc, create a new
section (Insert > Break > Section Break).



INTRODUCTION

Lorem ipsum dolor sit amet, consectetur adipiscing elit. Etiam feugiat auctor rhoncus.
Nam eget massa id enim finibus tristique. Suspendisse consectetur lacus purus, quis efficitur
ipsum facilisis sit amet. Proin hendrerit, orci non consectetur semper, mauris felis blandit turpis,
ut finibus urna ipsum a dolor. Sed sapien nisi, suscipit et laoreet sed, condimentum eget lacus.
Class aptent taciti sociosqu ad litora torquent per conubia nostra, per inceptos himenaeos. Sed
nec ultrices sapien. Quisque faucibus consequat arcu.

Cras in nibh egestas orci venenatis ullamcorper. Proin vitae tellus mi. Morbi velit dui,
accumsan at dolor euismod, maximus volutpat ex. Proin ac sollicitudin est. Quisque mattis
consectetur diam id eleifend. Quisque at libero ac diam elementum semper. Nam accumsan diam
ut mi pretium, eu varius sem suscipit. In ac molestie justo. Integer purus arcu, cursus ut vulputate
nec, sagittis eget dolor. Ut sed nunc dapibus, sodales nunc ut, auctor ante. Duis non ullamcorper
odio. Phasellus in tristique orci. Maecenas facilisis libero nec dui blandit mattis.

Curabitur lobortis, quam nec mollis lacinia, diam ante ullamcorper erat, sit amet
consectetur diam risus nec lorem. Maecenas ipsum quam, dictum sit amet cursus et, pretium vel
eros. Quisque ante massa, vehicula sollicitudin mauris et, posuere laoreet justo. Maecenas
tempus odio erat, vitae vulputate lorem egestas sit amet. Phasellus placerat sed mi nec
sollicitudin. Pellentesque ac risus velit. Donec iaculis et mauris vel ullamcorper. Vestibulum
pharetra semper tristique. Donec nec lacus sapien. Etiam malesuada viverra nunc vel interdum.
Integer urna sapien, varius ut quam sed, tempor ullamcorper erat. Praesent finibus lectus libero,
nec accumsan ante tincidunt vel.

Nam sed quam eget leo molestie feugiat. Sed a egestas augue. In placerat facilisis

commodo. Nunc aliquet risus eu ipsum mollis, sit amet sagittis purus venenatis. In quis



vestibulum mi. Sed convallis dui orci, eget luctus neque faucibus vel. Duis at massa vel mauris
tempus rutrum eget vel ipsum. Praesent posuere dui et ullamcorper cursus. Ut non scelerisque
ipsum, nec eleifend nisi. Ut scelerisque eros eu enim commodo posuere.

In vehicula congue maximus. Phasellus hendrerit molestie sapien, ut vehicula purus.
Vivamus vel nulla eget lectus egestas bibendum. Cras sem turpis, commodo eget dictum ac,
accumsan quis enim. Quisque mattis magna sit amet diam porttitor sollicitudin. Sed dui elit,

commodo sit amet libero non, mollis volutpat dui. Pellentesque ut laoreet enim.



CHAPTER ONE
Title for Chapter One

Lorem ipsum dolor sit amet, consectetur adipiscing elit. Etiam feugiat auctor rhoncus.
Nam eget massa id enim finibus tristique. Suspendisse consectetur lacus purus, quis efficitur
ipsum facilisis sit amet. Proin hendrerit, orci non consectetur semper, mauris felis blandit turpis,
ut finibus urna ipsum a dolor. Sed sapien nisi, suscipit et laoreet sed, condimentum eget lacus.
Class aptent taciti sociosqu ad litora torquent per conubia nostra, per inceptos himenaeos. Sed
nec ultrices sapien. Quisque faucibus consequat arcu.

Cras in nibh egestas orci venenatis ullamcorper. Proin vitae tellus mi. Morbi velit dui,
accumsan at dolor euismod, maximus volutpat ex. Proin ac sollicitudin est. Quisque mattis
consectetur diam id eleifend. Quisque at libero ac diam elementum semper. Nam accumsan diam
ut mi pretium, eu varius sem suscipit. In ac molestie justo. Integer purus arcu, cursus ut vulputate
nec, sagittis eget dolor. Ut sed nunc dapibus, sodales nunc ut, auctor ante. Duis non ullamcorper
odio. Phasellus in tristique orci. Maecenas facilisis libero nec dui blandit mattis.

Curabitur lobortis, quam nec mollis lacinia, diam ante ullamcorper erat, sit amet
consectetur diam risus nec lorem. Maecenas ipsum quam, dictum sit amet cursus et, pretium vel
eros. Quisque ante massa, vehicula sollicitudin mauris et, posuere laoreet justo. Maecenas
tempus odio erat, vitae vulputate lorem egestas sit amet. Phasellus placerat sed mi nec
sollicitudin. Pellentesque ac risus velit. Donec iaculis et mauris vel ullamcorper. Vestibulum
pharetra semper tristique. Donec nec lacus sapien. Etiam malesuada viverra nunc vel interdum.
Integer urna sapien, varius ut quam sed, tempor ullamcorper erat. Praesent finibus lectus libero,

nec accumsan ante tincidunt vel.



Nam sed quam eget leo molestie feugiat. Sed a egestas augue. In placerat facilisis
commodo. Nunc aliquet risus eu ipsum mollis, sit amet sagittis purus venenatis. In quis
vestibulum mi. Sed convallis dui orci, eget luctus neque faucibus vel. Duis at massa vel mauris
tempus rutrum eget vel ipsum. Praesent posuere dui et ullamcorper cursus. Ut non scelerisque
ipsum, nec eleifend nisi. Ut scelerisque eros eu enim commodo posuere.

In vehicula congue maximus. Phasellus hendrerit molestie sapien, ut vehicula purus.
Vivamus vel nulla eget lectus egestas bibendum. Cras sem turpis, commodo eget dictum ac,
accumsan quis enim. Quisque mattis magna sit amet diam porttitor sollicitudin. Sed dui elit,

commodo sit amet libero non, mollis volutpat dui. Pellentesque ut laoreet enim.
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